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SCC-RTDO1 Resistance
Temperature Detector

The SCC-RTDOL resistance temperature detector (RTD) input module
accepts up to two RTD input signals from 2-, 3-, or 4-wire RTDs. Each
module consists of two RTD input channels, a 30 Hz Butterworth lowpass
filter for each channel, and a 1 mA excitation current source. Each input
channel includes an instrumentation amplifier with differential inputs and
a fixed gain of 25.

The SCC-RTDOL filters RTD inputs and passes them through a differential
amplifier with a fixed gain of 25 resulting in a maximum input voltage of
400 mVDC. The output of the amplifier passes through a three-pole, 30 Hz
Butterworth lowpass filter. The SCC-RTDO1 provides a 1 mA excitation
current source for RTDs.

Conventions

The following conventions are used in this guide:

» The » symbol leads you through nested menu items and dialog box options
to a final action. The sequence File»Page Setup»Options directs you to
pull down the File menu, select the Page Setup item, and select Options
from the last dialog box.

This icon denotes a note, which alerts you to important information.
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This icon denotes a caution, which advises you of precautions to take

to avoid injury, data loss, or a system crash. When this symbol is marked
on the product, refer to the Read Me First: Safety and Radio-Frequency
Interference document, shipped with the product, for precautions to take.

When symbol is marked on a product, it denotes a warning advising you to
take precautions to avoid electrical shock.

When symbol is marked on a product, it denotes a component that may be
hot. Touching this component may result in bodily injury.
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bold

italic

monospace

SC-2345

ScC

Application Development Environment

Bold text denotes items that you must select in software, such as menu
items and dialog box options. Bold text also denotes parameter names.

Italic text denotes variables, emphasis, a cross-reference, or an introduction
to a key concept. Italic text also denotes text that is a placeholder for a word
or value that you must supply.

Text in this font denotes text or characters that you should enter from the
keyboard, sections of code, programming examples, and syntax examples.
This font is also used for the proper names of disk drives, paths, directories,
programs, subprograms, subroutines, device names, functions, operations,
variables, filenames, and extensions.

SC-2345 refers to both the SC-2345 connector block and the SC-2345 with
configurable connectors.

SCC refers to any SCC Series signal conditioning module.

What You Need to Get Started

To set up and use the SCC-RTDO1, you need the following items:

U Hardware
- SCC-68
or
—  SC-2345/2350 with one of the following:
*  SCC-PWRO1
e SCC-PWRO02 and the PSO1 power supply

e SCC-PWRO3 (requires a 7 to 42 VDC power supply,
not included)

—  One or more SCC-RTDO0O1 modules
—  68-pin E/M Series DAQ device

—  68-pin cable

—  Quick Reference Label

U Software
—  The latest version of NI-DAQmx
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U Documentation
—  One of the following:
o SC-2345/2350 User Manual
*  SCC-68 User Guide
—  SCC-RTDOI Resistance Temperature Detector User Guide
—  Read Me First: Safety and Radio-Frequency Interference
—  SCC Quick Start Guide

U Tools
— 1/8 in. flathead screwdriver
—  Numbers 1 and 2 Phillips screwdrivers

—  Wire insulation strippers

@ Note If you do not have the current version of NI-DAQmx or one of the documents, you
can download them from the National Instruments Web site at ni . com or contact an NI
sales representative. Software scaling of measurements is not supported on the Macintosh
operating system. Refer to the Specifications section for information about software
scaling.

Device Specific Information

@ Note For general SCC module installation and signal connection information, and
information about the SC-2345 or SC-2350 carrier, refer to the SCC Quick Start Guide,
available for download at ni .com/manuals.

Installing the Module

A Caution Refer to the Read Me First: Safety and Radio-Frequency Interference document
before removing equipment covers or connecting/disconnecting any signal wires.

You can plug the SCC-RTDOI into any Al socket on the SCC.

The SCC-RTDOI can function as a single-stage module or as the first stage
of a dual-stage signal conditioning configuration. The socket you choose
determines which E/M Series DAQ device channels receive the
SCC-RTDO1 signals, as explained in the SCC Quick Start Guide.

For single-stage input conditioning, plug the SCC-RTDO01 into any socket

J(X+1), where X is O to 7, and connect the input signals to the module as
described in the SCC Quick Start Guide.
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If you use the SCC-RTDO1 in a dual-stage configuration, the SCC-RTDO1
must be the first stage. Plug the SCC-RTDO1 into any socket J(X+9) and
plug the second-stage SCC into socket J(X+1), where X is 0 to 7. Connect
the input signals to the SCC-RTDOI as described in the SCC Quick Start
Guide. The SC-2345 connects the output signals of the first-stage SCC to
the inputs of the second-stage SCC. An example of dual-stage conditioning
is an SCC-AIXX isolated analog input module followed by an SCC-LPXX
lowpass filter module.

E Note Refer to the SC-2345/2350 User Manual for more information on single-stage and
dual-stage signal conditioning and configuration.

Connecting the Input Signals

@ Note The signal names have changed. Refer to ni.com/info and enter rdtntg to
confirm the signal names.

The SCC-RTDO1 has six pins and provides two differential Al channels for
measuring the voltage across RTDs. Pins 1 and 2 form a differential
channel routed to E/M Series DAQ device channel X+8, and pins 3 and 4
form a second differential channel routed to E/M Series DAQ device
channel X, where X is 0 to 7 depending on the socket of the SCC-RTDO1.
Pins 5 and 6 carry the 1 mA constant-current excitation source.

For information on how the I/O pins on the bottom of the SCC-RTDO1
correspond to signals on the E/M Series DAQ device, refer to the /0
Connector Pin Assignments section.

Signal sources can be floating or ground-referenced. The SCC-RTDOI has
high-impedance bias resistors typically required for floating sources.
Therefore, floating signal sources do not require external bias resistors
connected to ground.

@ Note For floating signal sources in high-noise environments, connect the negative
terminal of the signal source to the AI SENSE terminal on the SC-2345/2350
screw-terminal block to reduce common-mode noise.

You can connect one or two RTDs to the SCC-RTDOI1 in 2-, 3-, and 4-wire
configurations. Figure 1 contains wiring diagrams for connecting one 2-,
3-, or 4-wire RTD to the SCC-RTDO1.
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Figure 1. SCC-RTDO1 Single-Channel Wiring Diagrams
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Figure 2 contains wiring diagrams for connecting two 2-, 3-, or 4-wire
RTDs to the SCC-RTDOLI.

Red
Red SCC-RTDO1
6
RTD * lex (1 MA
5 J} ex ( )
4 E/M Series
3 Al (X)
2 E/M Series
RTD 1 Al (X+8)
Black 4-Wire, 2 Channels
Red
SCC-RTDO1
— 6
RTD +Zi) ley (1 MA
%\ Black M 51— ex (1mA)
Black — 4 E/M Series
Red ( 3 Al (X)
— R ——{2 E/M Series
RTD 1 Al (X+8)
£/ Black :
Black 3-Wire, 2 Channels
Red
SCC-RTDO1

% lex (1 mA)

RTD
Black
E/M Series
Al (X)

Red g _
E/M Series
RTD Al (X+8)
Black 2-Wire, 2 Channels

Figure 2. SCC-RTDO1 Two-Channel Wiring Diagrams

- DD W b~ OO

@ Note Use 4-wire transducer connections for a more accurate measurement. Lead
resistance in 2- and 3-wire connections can introduce measurement errors.

For information about configuring the SCC-RTD01 module using
NI-DAQmX, refer to the SCC Quick Start Guide.
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Using the SCC-RTDO1

@ Note If you have an RTD that is not supported in Measurement & Automation
Explorer (MAX), Read Voltage Data and scale it in your ADE.

Converting Voltage Measurements to Temperature Measurements

If you use MAX to configure the SCC-RTDO1, the reading you get from
the E/M Series DAQ device is properly scaled. Otherwise, you must scale
the readings and convert the voltage measurement to temperature by
performing the following steps to use the standard equations for platinum

RTDs:

1.  Measure the RTD voltage.

a.

Read the RTD channel on the E/M Series DAQ device and call the
value Viggries[CH(X)].

Calculate the RTD voltage using the following formula:

v _ VESER[ES
RTD — 25

where
Vrrp is the SCC-RTDO1 input voltage.
Veseries 1 the E/M Series DAQ device voltage.

2. Use polynomial expressions or a conversion table provided by the RTD
vendor to convert the RTD voltage to temperature.

@ Note NI programming environments include RTD conversion utilities that implement the
voltage-to-temperature conversions. Refer to the ADE documentation for more
information on these utilities.

Although the RTD resistance-versus-temperature curve is relatively
linear, accurately converting resistance to temperature requires curve
fitting. The Callendar-Van Dusen equation is commonly used to
approximate the RTD curve:

R, =R,[1 + At + B2 + C(t — 100)*]

where
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R, is the resistance of the RTD at temperature ¢.
R, is the resistance of the RTD at 0 °C.

A, B, and C are the Callendar-Van Dusen coefficients shown in
Table 1.

t is the temperature in °C.
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Table 1. Callendar-Van Dusen Coefficients for Platinum RTDs

Temperature
Standard Coefficient A B C
DIN 43760 0.003850 3.9080 x 1073 -5.8019 x 107 | —-4.2735x 10712
American 0.003911 3.9692 x 103 -5.8495 x 1077 | -4.3235x 1012
ITS-90 0.003926 3.9848 x 1073 -5.870 x 1077 —-4.0000 x 1012

SCC-RTDO1 Resistance Temperature Detector User Guide

For temperatures above 0 °C, the C coefficient equals 0. Therefore, for
temperatures above 0 °C, this equation reduces to a quadratic. If you
pass a known current, Iy, through the RTD and measure the voltage
developed across the RTD, V,,, you can use the following formula to

solve for

=

where

2(V0 B IEXRO)

Vp is the measured RTD voltage.

Iy is the excitation current.

LyRolA + JA> + (4B(Vy — LyRo))/ (LpxRo)]

Most platinum RTD curves conform to one of the following three
standardized curves:

e DIN 43760 standard

e U.S. Industrial or American standard

e International Temperature Scale (ITS)-90 (for use with

wire-wound RTDs)
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Specifications

These ratings are typical at 25 °C unless otherwise stated.
Analog Input
Number of input channels...................... 2 DIFF

INput range .......ceceveevienienineeeeeeeeen 1400 mVDC (fixed gain of 25 on
each channel)

Overvoltage protection..........c..ceeeveennee. 142 VDC powered on
125 VDC powered off

Input impedance

Normal powered on ........ccceeeueenen. 2 MQ in parallel with 4.7 nF
Powered off..........cccoevviiiiiiinnnnn 20 kQ min
Overload........cccocvviviiiiiiicicinnne. 20 kQ min
FIlter type ..ccveeevenveeieiieiciececeeeeeee 3-pole Butterworth lowpass filter
—3 dB cutoff frequency ...........c...... 30 Hz
SYStemM NOISE ....oevveeerieeeeieeeereeireieeaeens 4.5 uV s (referred to the input
[RTI]')

Transfer Characteristics

G e 25

GalN eITOT ...t +1.2%
Gain-error temperature coefficient......... +10 ppm/°C
OFfSet €ITOT .....cvveeeeeeeeeeeeeeeeeeeeeen 1250 uV (RTI)

Offset-error temperature coefficient ...... 1.6 pV/°C
Nonlinearity ........cccceevevvvenieeenienceennennee 10 ppm of full scale
Recommended warm-up time ................ 5 min

Amplifier Characteristics
Common-mode rejection ratio ............... 110 dB at 60 Hz

OUtput TANZE....ccuveeeeirieeniieeieenieeieeaeean 10V

! Calculated relative to the input range of the module.
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Excitation

Number of channels........ccccccvevevvvinnnnennn. 1

Constant-current SOUICe..........c..ceeevenes 1 mA, £ 0.4 pA or 0.04%

Maximum voltage level
without regulation 10ss..........cccceveeriennene 24V

Drift e +127 ppm/°C

Power Requirement

Analog POWET ......ccccevieieniinieieniecieneene 135 mW max
FIS Vo 4.5 mA max
IS5V 4.5 mA max
Digital POWET ....cceoveeneeriiiinienenieicnene 153 mW max
F5 Ve 30.6 mA max
Physical
1.87 cm
, (0.74in) 793 cm .
== (3.12in.) >
I
=
Eﬂ (1 4 in.)
L l
Figure 3. SCC-RTDO1 Dimensions
Weight ..ot 24 ¢ (0.8 0z)
I/0 connectors..........coeevevuereecreneneennenne 20-pin right-angle
male connector,
6-pin screw terminal
Field-wiring diameter ...........c.ccccccecueuee 28to 16 AWG
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Maximum Working Voltage

Maximum working voltage
(signal plus common mode)................... Each input should remain within
+12 V of ground

Measurement Category 1

Environmental
Operating temperature............cocceeveeveenee. 0to 50 °C
Storage temperature .........ceceervveerveerueenns —20to0 70 °C
Humidity ....ccoooeeeiiniiiiniiiicceeee 5 to 90% relative humidity,
noncondensing
Maximum altitude ...........ooovvveveveiininnnns 2,000 m
Pollution Degree (indoor use only)........ 2

Safety

This product is designed to meet the requirements of the following
standards of safety for electrical equipment for measurement, control,
and laboratory use:

« IEC61010-1, EN-61010-1
* UL 61010-1, CAN/CSA-C22.2 No. 61010-1

@ Note For UL and other safety certifications, refer to the product label or visit
ni.com/certification, search by model number or product line, and click the
appropriate link in the Certification column.

Electromagnetic Compatibility

This product is designed to meet the requirements of the following
standards of EMC for electrical equipment for measurement, control,
and laboratory use:

* EN 61326 EMC requirements; Minimum Immunity
e EN 55011 Emissions; Group 1, Class A
e CE, C-Tick, ICES, and FCC Part 15 Emissions; Class A

@ Note For EMC compliance, operate this device according to product documentation.
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CE Compliance

This product meets the essential requirements of applicable European
Directives, as amended for CE marking, as follows:

»  73/23/EEC; Low-Voltage Directive (safety)
*  89/336/EEC; Electromagnetic Compatibility Directive (EMC)

@ Note Refer to the Declaration of Conformity (DoC) for this product for any additional
regulatory compliance information. To obtain the DoC for this product, visit
ni.com/certification, search by model number or product line, and click the
appropriate link in the Certification column.

Waste Electrical and Electronic Equipment (WEEE)
g EU Customers At the end of their life cycle, all products must be sent to a WEEE recycling

center. For more information about WEEE recycling centers and National Instruments
WEEE initiatives, visit ni.com/environment /weee.htm.

I/0 Connector Pin Assignments

Figure 4 shows the I/O connector pins on the bottom of the module.

/@

0000000000
0,0 0000000 0%t+—2)
1 Pin1 2 Pin2 3 PWB Key 4 Pin19 5 Pin20 ‘

Figure 4. SCC Module Bottom View
Table 2 lists the signal connection corresponding to each pin. Al (X)

and Al (X+8) are the Al signal channels of the E/M Series DAQ device.
AI GND is the AI ground signal and is the reference for Al (X) and
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AI (X+8). A GND is the reference for the £15 V supplies and REF 5 V.

AI GND and A GND connect to the SC-2345/2350 at the SCC-PWR

connector. GND is the reference for the +5 V supply.

Table 2. SCC-RTDO1 Pin Signal Connections

Pin Number Signal
1 DAQ Device Al (X)
2 DAQ Device AI GND
3 —
4 DAQ Device Al (X+8)
5 —
6 DAQ Device Al GND
7 —
8 DAQ Device AI GND
9 +5V
10 GND
11 A GND
12 —
13 +15V
14 -15V
15 —
16 —
17 —
18 —
19 —
20 —

National Instruments, NI, ni.com, and LabVIEW are trademarks of National Instruments Corporation.

Refer to the Terms of Use section on ni . com/legal for more information about National

Instruments trademarks. Other product and company names mentioned herein are trademarks or trade
names of their respective companies. For patents covering National Instruments products, refer to the

appropriate location: Help»Patents in your software, the patents . txt file on your CD, or
ni.com/patents.
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